
Software & Labeling Instruction Booklet

Creating a New Label
Creating a new label with Maxell CreateIt™ is fast and easy.

1. Click the New button on the Command Bar or choose New from the File menu. The New CD Wizard is launched.

2. On the Select Label 
Stock screen, select the 
appropriate Product Type 
and Label Product you 
are using. 

Click Next.

3. On the Custom Backgrounds 
Wizard screen, you can click the 
Browse button if you wish to 
select a colourful background.

Click Next.

     (Use the Browse button to select a            �
      colorful background for your label.) 

Starting                CreateItTM

Double-click the Maxell CreateItTM icon on the desktop, or launch it from the Start menu (look under Programs > Maxell >l Maxell > Maxell CreateItTM).

SOFTWARE QUICK START GUIDE (powered by SureThing®)

Viewing and Printing the Manual
The complete Maxell CreateItTM user's guide is installed with this program.
To access the User's Guide, click Start > Programs > Maxell > Maxell CreateItTM User's Guide.
The User's Guide will be automatically launched in Adobe Acrobat Reader. You can easily print any or all sections of the User's Guide from within 
Adobe Acrobat Reader.

Registration
Be sure to register Maxell CreateItTM online during the installation or any time you run the program. Registering entitles you to:
- Technical support
- Notification of program updates and upgrades

Registering during installation
1. Make sure the register online box is checked.
2. Click Finish and the online registration page will be displayed in your default browser.
3. Complete the form and click Register.

Registering from the program
1. Choose Register SureThing® from the Help menu.
2. Click Register Online to display the registration page in your browser.
3. Complete the form and click Register.

Where to Find Help
- Maxell CreateItTM provides help tips in certain areas, such as wizard screens, to help explain more complicated procedures and give helpful hints �
  to make your work with Maxell CreateItTM more productive.
- The Help menu provides access to many important support features, such as SureThing® Help, Online Tutorials, Popup Help, Tips of the Day as �
  well as Internet support, including News and Special Offers, Program Updates and Support Groups.
- Context-sensitive Help is avaiilable in every Maxell CreateItTM window. Just press F1 or click the Help button!
- Feature-related tutorials take you step-by-step through many of Maxell CreateIt'sTM capabilities, including creating a new label, working in the ��
  design area, creatng text effects and working with playlists.



Creating a New Label Continued...

4. On the SmartDesigns Wizard screen, select 
whether or not you would like to use Smart 
Designs via the SmartDesigns check box. Use the 
Design Variation Bar to select a label layout. 

When you are finished click Next.

            (The Design Variation Bar lets you scroll through design ��
            changes or pop up this menu. The selections are shown �
            on the label.)

Using the Design Variation Bar�

 - Click on the > arrow to advance to the next selection. ��
   Notice how your design changes.
 - Click on the < arrow to move back to the previous ��
   selection.
 - Click and hold the < or > arrow to scroll through the ��
   selections.
 - Click on name in the control to pop up a menu with �
   all the available choices.

5. All you need to do know is click on the Finish button!

Using the Design Bar
The Maxell CreateItTM Design Bar lets you customize your label quickly and easily.

Pick from a wide variety of pre-designed backgrounds or choose one of your own. Watch as they are applied to your design instantaneously.

Browse through thumbnails of logos, clipart and CD and media symbols or brose for your own pictures.

Make your designs stand out with Text Effects. Wrap text around curves, set it on an angle or an arch, rotate it, etc. Create full-colored text fills, drop shadows, 
and more.

While we recommend browsing Maxell CreateIt'sTM SmartDesign layouts first, you may need to add a text frame from time to time. You can do so with this button.

Using the Variation Bar

Object Mode and Text Mode
An important thing to remember in Maxell CreateIt™ is that there are two modes. Object Mode and Text Mode. To switch between modes simply click on the corresponding button 
located at the top left corner of your screen. 

Background Bar Layout Bar Font Bar

The Variation Bar lets you cycle through the various SmartDesigns available to a particular label stock. You can change the background, layout and font set of the design simply 
by clicking on the left or right arrows on each bar.

Background Bar: The Background Bar allows the user to scroll through various backgrounds installed with Maxell CreateIt™. You can also find these backgrounds by clicking on 
the background button and choosing the Browse SmartDesign Backgrounds option.

Layout Bar: This bar contains the available layouts designed for the chosen background. The layouts are designed with music CD's and other general purpose setups in mind.

Font Bar: Fonts are an excellent way to change the feeling of any design. Maxell CreateIt™ SmartDesigns are configured with several font variations to fit the kind of design you 
are working on. Simply click on the left or right arrow buttons on the bar to choose between font variables.

 The I-Beam is the icon to choose if you wish to be in Text Mode. When you are in Text Mode you can click inside any text-frame to edit the text within it.

Click on the Pointer Tool button to get into Object Mode. Object Mode allows you to move boxes, change their sizes and edit their properties by double-clicking on them.  

Printing in                 CreateItTM

The print dialogue box has several important features intended to make printing as comprehensive as possible. Here are a few of the most important features of the print �
dialogue box. �

Number of Labels to print : Printing multiple copies of your label design is simple! Just enter how many copies you'd like 
to print here. You may also choose to print a whole sheet or sheets of labels by checking the "Based on label sheets" box. 
Changing the number of labels or sheets will change the value for the "Sheets Required" notation under the template 
preview box.

Select Starting Label Preview: If you have paper that has been partially used, select the label you would like Maxell 
CreateIt™ to begin printing on by clicking on it in the preview. The label you have chosen will turn blue. If you are printing 
more than one label, the labels after the one selected will also turn blue.

Advanced Options: This dialogue box is where you find the crop marks, print to file and clip to label features. The crop 
marks feature is especially helpful if you are printing to non-perforated card stock.

Change Stock: If the template you see in the starting label preview box is not the same as the paper you will be printing to, 
click on this button to select the template that matches your paper.

Calibrating your Printer: Because each printer is full of working parts, the precision in each is slightly different. Sometimes 
this may cause SureThing to slightly miss the mark when printing. If this happens, you need to calibrate your printer. (Please 
reference the calibration data in the User's Guide which is installed on the CreateIt™ software disc enclosed.)



STANDARD CD/DVD LABELS (Matte or Glossy Sheets)

JEWEL CASE SPINE LABELS

MINI CD LABELS (3" / 8 cm)

eBUSINESS DISC LABELS

JEWEL CASE SONG BOOKLET

After printing your label, 
tear the full sheet in half 
along the perforation 
line. Flip the label sheet 
over so the printed side 
is face down. 

Using the pull-tab, peel 
and remove the backing 
sheet from your label. 
The 2 tab holes and the 
centre disc hole should 
pop out during this 
process. 

Place the label sheet 
printed side down onto 
the applicator, using the 
tab pins for proper 
alignment.

Close the applicator lid 
over your CD/DVD label.

Place your CD/DVD 
onto the applicator, 
using the centre guide 
to help align your disc. 
Holding your CD/DVD 
along the outside edge 
will ensure your disc will 
not be damaged.

Apply downward 
pressure to your disc, 
securing it to your label. 
Take care not to scratch 
the written surface of 
your CD/DVD disc.

Leaving the applicator 
closed, lift and remove 
the disc by inserting 
finger into the finger 
notch (from above or 
below) and pulling the 
labeled CD/DVD up and 
away from the backing 
sheet.

Store the finished disc in 
a jewel case or storage 
device.

After printing and 
applying your CD/DVD 
label, peel and remove 
the backing to the spine 
label from the remaining 
label sheet. 

Place the label sheet 
back onto the applicator 
face down. Close the 
applicator lid over the 
label sheet. 

Insert the desired end of 
your jewel case into the 
spine label slot of the 
applicator. Press down 
firmly to apply label. 

Lift and remove the 
jewel case from the 
applicator to finish the 
application.

KEY RECOMMENDATIONS

Re-Using Standard CD/DVD label sheets (Matte or Glossy): After 
printing on your 1/2 sheet, do not attempt to re-print the sheet once 
any labels have been removed.

Printing Glossy Labels: To avoid ink smudges, allow a 90 second 
drying tome before handling the printed label surface.

After printing your �
label (s), tear the full 
sheet into 4 pieces 
along the perforation 
lines. Flip your label 
sheet section over so 
the printed side is face 
down. 

Using the pull-tab, peel 
and remove the backing 
sheet from your label. 
The 2 tab holes and the 
centre disc hole should 
pop out during this 
process.

Place the label sheet 
printed side down onto 
the applicator, using the 
tab pins for proper 
alignment.

Close the applicator lid 
over your Mini CD label.

Place your Mini CD onto 
the applicator, using the 
centre guide to help 
align your disc. Holding 
your Mini CD along the 
outside edge will ensure 
your disc will not be 
damaged.  

Apply downward 
pressure to your disc, 
securing it to your label. 
Take care not to scratch 
the written surface of 
your Mini CD.  

Leaving the applicator 
closed, lift and remove 
the disc by inserting 
finger into the finger 
notch (from above or 
below) and pulling the 
labeled Mini CD up and 
away from the backing 
sheet. 

Store the finished disc in 
a jewel case or storage 
device.

After printing your 
label(s), tear the full 
sheet into 4 pieces 
along the perforation 
lines. Flip your label 
sheet section over so 
the printed side is face 
down.     

Using the pull-tab, peel 
and remove the backing 
sheet from your label. 
The 2 tab holes and the 
centre disc hole should 
pop out during this 
process.   

Place the label sheet 
printed side down onto 
the applicator, using the 
tab pins for proper 
alignment. 

Close the applicator lid 
over your eBusiness 
disc label.   

Place your eBusiness 
disc onto the applicator, 
using the centre guide to 
help align your disc. 
Holding your eBusiness 
disc along the outside 
edge will ensure your 
disc will not be 
damaged. 

Apply downward 
pressure to your disc, 
securing it to your label. 
Take care not to scratch 
the written surface of 
your eBusiness Disc. 

Leaving the applicator 
closed, lift and remove 
the disc by inserting 
finger into the finger 
notch (from above or 
below) and pulling the 
labeled eBusiness Disc 
up and away from the 
backing sheet. 

Store the finished disc in 
a jewel case or storage 
device. 

After printing your jewel 
case song booklet, 
remove the booklet by 
tearing along the outside 
perforations. 

Fold your song booklet 
in half along the centre 
score line. The booklet 
should now have the 
cover facing up with the 
fold on the left.

With your jewel case 
open, slide the song 
booklet face down under 
the jewel case lid tabs. 

Close your jewel case 
and inspect your printed 
song booklet. Make any 
necessary adjustments 
by repeating the 
previous steps.     



CD/DVD Label Kit Multi-Purpose Kit for ALL Disc Sizes

LK-3 LK-4 LK-5 LK-6 LK-7

CD/DVD MATTE White Refill Pack

25 Sheets (50 disc labels, 50 spine 
labels, 150 multi-purpose labels)

CD/DVD GLOSSY White Refill Pack

25 Sheets (50 disc labels, 50 spine 
labels, 150 multi-purpose labels)

Mini CD MATTE Labels Refill Pack 

30 Sheets (120 Mini CD Labels)

CD/DVD MATTE White Value Pack

50 Sheets (100 disc labels, 100 spine 
labels, 300 multi-purpose labels)

www.maxell.com

LABELING PRODUCTS

Kit Includes:
- Multi -Purpose Exact Fit Applicator
- Software powered by SureThing SE Edition
- Matte White Labels (10 sheets including 2 CD/DVD, �
  2 spine, 6 multi-purpose labels per sheet)
- Glossy White Labels (1 sheet including CD/DVD, �
  2 spine, 6 multi-purpose labels per sheet)
- Matte Jewel Case Inserts (5 Standard Inserts or �
  1 Slimline Inserts)
- Matte Jewel Case Song Booklets (6 sheets including 
  1 booklet per sheet)

LK-1 LK-2
Kit Includes:
- Multi -Purpose Exact Fit Applicator
- Software powered by SureThing SE Edition
- Matte White Labels (12 sheets including 2 CD/DVD, �
  2 spine, 6 multi-purpose labels per sheet)
- Glossy White Labels (6 sheets including 2 CD/DVD, 
  2 spine, 6 multi-purpose labels per sheet)
- Matte Jewel Case Inserts (6 Standard Inserts or �
  12 Slimline Inserts)
- eBusiness Labels (4 sheets including 4 labels �
  per sheet)
- Mini CD Labels (3 sheets including 4 labels 
  per sheet)

Jewel Case Inserts Matte Refill Pack

25 Jewel Case Sheets (25 Standard 
Inserts or 50 Slim Inserts)

5 Song Booklet Sheets (5 Standard 
Booklets or 10 Slim Booklets

GETTING HELP!
Visit our website www.maxell.com and click "FAQs" for answers to frequently asked questions.

For Technical Support, call 800-377-5887 or e-mail us at:  techsupp@maxell.com

For further technical assistance, visit the SureThing® website at www.surething.com

90-Day Limited Warranty
Maxell warrants this product to be free from manufacturing defects in materials and workmanship for a period of 90 days from the date of original purchase.
Any product found to be defective will be replaced at no charge, during the warranty period, if it is returned with proof of purchase to:
Maxell Corporation of American, P.O. Box 900, Fair Lawn, NJ 07410-0900.
Manufacturer, distributor and seller shall not be liable for consequential commercial damages. Some states do not allow a limitation with respect to consequential damages.
This warranty gives you specific legal rights, and you may have other rights which vary from state to state.

*All trademarks are property of their respective holders.

JEWEL CASE INSERTS

SLIMLINE JEWEL CASE FRONT INSERT(S)

STANDARD JEWEL CASE BACK W/SPINE INSERTS & STANDARD FRONT INSERT

After printing your Front 
Insert for your slimline 
jewel case, remove the 
insert by tearing along the 
outside perforations.

With your jewel case 
open, slide the front insert 
face down under the 
jewel case lid tabs.

Close your slimline jewel 
case and inspect your 
printed insert. Make any 
necessary adjustments 
by repeating the previous 
steps.

To use the second Front 
Insert for your jewel 
case, remove the insert 
by tearing along the 
inside perforations. Be 
sure to tear at the 
extended top edge (A). 
Repeat steps 2 and 3 to 
finish.

After printing your Front 
Insert for your slimline 
jewel case, remove the 
insert by tearing along 
the outside perforations.

Flip the sheet over so the 
printed side is face 
down. Fold the Spine 
flaps up at a 90 degree 
angle along the score 
lines.

Remove the disc tray  
your standard jewel case 
by carefully lifting it out of 
the locking tabs.

Place your folded insert 
into the bottom of your 
jewel case.

Replace the disc tray into 
your jewel case. Locking 
one end at a time will 
help keep the spine flaps 
in place.

If you have printed a 
standard front Insert 
remove it by tearing 
along the perforations.

With your jewel case 
open, slide the front 
insert face down under 
the jewel case lid tabs.

Close your standard 
jewel case and inspect 
your printed inserts. 
Make any necessary 
adjustments by repeating 
the appropriate steps.


